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Part 1

General



Chapter 1

Introduction

SpiderBasic is an “high-level” programming language based on established "BASIC” rules. It does share
background with other "BASIC” compiler, but has its own syntax extensions. Learning SpiderBasic is
very easy! SpiderBasic has been created for beginners and experts alike. Compilation time is extremely
fast. We have put a lot of effort into its realization to produce a fast, reliable and system-friendly
language.

The syntax is easy and the possibilities are huge with the "advanced” functions that have been added to
this language like structures, procedures, dynamic lists and much more. For the experienced coder, there
are no problems gaining access to external third party libraries.

The main features of SpiderBasic

- Huge set of internal commands (500+) to quickly and easily build applications or games
- BASIC based keywords

- Very fast compiler which creates optimized apps

- Procedure and structure support for advanced programming

- Built-in containers like array, list and map

- Strong types, strong syntax to avoid programming mistakes

- Full unicode support

- Namespace support for easy code reuse

- Easy but very fast 2D game support through WebGL

- Inlined JavaScript support for extensibility

- Dedicated editor and development environment

- Available on Windows, MacOS X and Linux

- Very close to PureBasic, which allow to port easily an application to the desktop



Chapter 2

Terms And Conditions

This program is provided ”AS IS”. Fantaisie Software are NOT responsible for any damage (or
damages) attributed to SpiderBasic. You are warned that you use SpiderBasic at your own risk. No
warranties are implied or given by Fantaisie Software or any representative.

The demo version of this program may be freely distributed provided all contents, of the original archive,
remain intact. You may not modify, or change, the contents of the original archive without express
written consent from Fantaisie Software.

SpiderBasic has an user-based license. This means you can install it on every computer you need but
you can’t share it between two or more people.

All components, libraries, and binaries are copyrighted by Fantaisie Software.

Fantaisie Software reserves all rights to this program and all original archives and contents.



Chapter 3

System requirements

SpiderBasic will run on Windows XP, Windows Vista, Windows 7 and Windows 8 (in both 32-bit and
64-bit edition), Linux (kernel 2.2 or above) and MacOS X (10.6 or above).
If there are any problems, please contact us.



Chapter 4

Installation

To install SpiderBasic, just click on the install wizard, follow the steps, and then click on the SpiderBasic
icon (found on the desktop or in the start-menu) to launch SpiderBasic.

To use the command line compiler, open a standard command line window (CMD) and look in the
"Compilers\” subdirectory for PBCompiler.exe. It’s a good idea to consider adding the
"SpiderBasic\Compilers\” directory to the PATH environment variable to make the compiler accessible
from any directory.

Important note: to avoid conflicts with existing SpiderBasic installations (maybe even with
user-libraries), please install a new SpiderBasic version always in its own new folder. See also the chapter
Using several SpiderBasic versions .



Chapter 5

Order

SpiderBasic is a low-cost programming language. In buying SpiderBasic you will ensure that
development will go further and faster. The updates are free until the next major version. For example,
when you buy SpiderBasic 1.00, all further 1.xx updates will be free, and the 2.00 version and above will
need a new registration fee. For ease of ordering, you can safely use our secure online method. Thanks a
lot for your support!

The demo-version of SpiderBasic is limited as shown below:

- maximum number of source lines: about 800

Full version of SpiderBasic:

Check http://www.spiderbasic.com for more information about pricing.

If you live in Germany or Europe and prefer paying to bank account you can
also send your registration to the German team member. In this case please
send your order to following address:

Andre Beer

Siedlung 6

09548 Deutschneudorf

Germany

e-mail: andre@spiderbasic.com

Bank Account:

Deutsche Kreditbank AG

Account 15920010 - Bank code 12030000

(For transactions from EU countries: IBAN: DE03120300000015920010 -
BIC/Swift-Code: BYLADEM1001)

Paypal:

andrebeer@gmx.de

(This address can be used for Paypal transaction, if you want
personal contact to or an invoice from Andre.)


http://www.spiderbasic.com

Delivering of the full version

The full version will be provided via your personal download account, which you will get on
www.spiderbasic.com after successful registration. If you order from Andre, just write an e-mail with
your full address or use this registration form and print it or send it via e-mail.
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Chapter 6

Contact

Please send bug reports, suggestions, improvements, examples of source coding, or if you just want to
contact us, to any of the following addresses:

Frederic ’AlphaSND’ Laboureur

Fred ’AlphaSND’ is the founder of Fantaisie Software and the main coder for SpiderBasic. All
suggestions, bug reports, etc. should be sent to him at either address shown below:

s-mail :

Frederic Laboureur
10, rue de Lausanne
67640 Fegersheim
France

e-mail : fred@spiderbasic.com

Andre Beer

Andpre is responsible for the complete German translation of the SpiderBasic manual and website.
SpiderBasic can be ordered in Germany also directly at him.

Just write an email with your full address (for the registration) to him. If needed you can also get an
invoice from him. For more details just take a look here.

e-mail : andre@spiderbasic.com
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Chapter 7
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Part 11

The SpiderBasic Editor
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Chapter 8

Getting Started

The SpiderBasic IDE allows you to create and edit your SpiderBasic source codes, as well as run them,
debug them and create the final project.
The IDE main window contains of 3 major parts:

M Gadget sb )-(| GadgetOverview sb X

18l
1a2
183
la4
185
186
187
188
189
11@
111
112
113
114
115
116
117
118
119
128
121
122
123
<

Procedures

Project | BExplorer

EndIf

CreateImage(@, 58, 5@)

If StartDrawing(ImageQutput(@))
Box(@, @, 5@, 58, RGB(255, @, @))
Circle{25, 25, 1@, RGE{255, 128, 8))
StopDrawing()

EndIf

;CopyImage(@, 19)

;ResizeImage(13, 28, 28)
sResizeImage(19, 41, 68, #PB_Image_Raw)
GrabImage(e, 19, 28, 28, 30, 28)

ButtonImagel = ButtonImageGadget(#PB_Any, 458, 218, 78, 78, ImageID(19))
; DisableGadget(ButtonImagel, #True)

ImageGadget (#PB_Any, 458, 298, 76, 78, ImageID(@))

TextGadget(#PE_Any, 1@, 338, 268, 28, "Label")
TextGadget(#PE_Any, 1@, 355, 288, 28, "Centered label"”, #PB_Text Center)

Textl = TextGadget(#PE_Any, 18, 386, 288, 28, "Gray & red right label”, #PB_Text

SetGadgetColor(Textl, #PB_Gadget BackColor, RGE(26@, 208, 268))

>

W

‘Welcome aboard !

AddListViewEwvent
SizeWindowEvent
CloseWindowEvent

The code editing area (below the toolbar)

Here all the source codes are displayed. You can switch between them with the tabs located

right above it.
The tools panel (on the right side by default)
Here you have several tools to make coding easier and increase productivity. The tools

displayed here can be configured, and it can even be completely removed. See Customizing

the IDE for more information.
The error log (located below the editing area)

In this area, the compiler errors and debugger messages are logged. It can be hidden/shown

for each source code separately.

14



Other then that, there is the main menu and the toolbar. The toolbar simply provides shortcuts to
menu features. It can be fully customized. To find out what each button does, move your mouse over it
and wait until a small tool-tip appears. It shows the corresponding menu command. The menu
commands are explained in the other sections.
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Chapter 9

Working with source files

The file menu allows you to do basic file operations like opening and saving source codes.

You can edit multiple source code files at the same time. You can switch between them using the panel
located under the Toolbar. Also the shortcut keys Ctrl+Tab and Ctrl+Shift+Tab can be used to jump
to the next or previous open source file, respectively.

The IDE allows the editing of non-sourcecode text files. In this "plain text” mode, code-related features
such as coloring, case correction, auto complete are disabled. When saving plain text files, the IDE will
not append its settings to the end of the file, even if this is configured for code files in the Preferences .
Whether or not a file is considered a code-file or not depends on the file extension. The standard
SpiderBasic file extensions (sb, sbi and sbf) are recognized as code files. More file extensions can be
recognized as code files by configuring their extension in the "Editor” section of the Preferences .

Contents of the ”File” menu:

2] New Ctrl+N
I Open... Ctrl+0O
= save Ctrl+5
[ Save As..
= Sawve All
[Z Reload
o Close Ctrl+W
Close All

= View changes
File format »
o Preferences...

Session History

Recent Files »

Quit
New
Create a new empty source code file.
Open

Open an existing source code file for editing.

Any text file will be loaded into the source-editing field. You can also load binary files with the Open
menu. These will be displayed in the internal File Viewer .

Save

16



Saves the currently active source to disk. If the file isn’t saved yet, you will be prompted for a filename.
Otherwise the code will be saved in the file it was saved in before.

Save As...

Save the currently active source to a different location than it was saved before. This prompts you for a
new filename and leaves the old file (if any) untouched.

Save All

Saves all currently opened sources.

Reload

Reloads the currently active source code from disk. This discards any changes not yet saved.

Close

Closes the currently active source code. If it was the only open code, the IDE will display a new empty
file.

Close All

Closes all currently opened sources.

View changes

Shows the changes made to the current source code compared to its version that exists on the hard drive.
File format

In this submenu you can select the text encoding as well as the newline format which should be used
when the currently active source code is saved to disk. The IDE can handle files in Ascii or UTF-8. The
newline formats it can handle are Windows (CRLF), Linux/Unix (LF) and MacOSX (CR). The defaults
for newly created source codes can be set in the preferences .

Preferences

Here you can change all the settings that control the look & behavior of the IDE. For a detailed
description of that see Customizing the IDE .

Session history

Session history is a powerful tool which regularly records changes made to any files in a database. A
session is created when the IDE launch, and is closed when the IDE quits. This is useful to rollback to a
previous version of a file, or to find back a deleted or corrupted file. It’s like source backup tool, limited
in time (by default one month of recording). It’s not aimed to replace a real source code version control
system like SVN or GIT. It’s complementary to have finer change trace. The source code will be stored
without encryption, so if you are working on sensitive source code, be sure to have this database file in a
secure location, or disable this feature. To configure the session history tool, see preferences .

Session | File

Session: | Curert Session

SpiderBasic - 2D Drawing example file

]:I] 10-30:55 (c) Fantaisie Software

E-[£] Gadget sh

i 10:17:51
10:18:45 10

: 10:24:23 11 If Openiindow(®, 108, 206, 388, 280, "20 [

g 10:31:02 12

13 ; Create an offscreen image, with a gree

14 ; It will be displayed later

15 H

16 If Createlmage(@, 308, 260)

17 If StartDrawing(ImageQutput(e))

18 Circle(180,10@,50,RGE(A,R,255)) ; :

15

20 Box(15@,20,20,28, RGE(®,255,8))

21

€

E-{£] 2DDrawing sb ;

Recent Files
Here you can see a list of the last accessed files. Selecting a file in this submenu will open it again.

Quit

This of course closes the IDE. You will be asked to save any non-saved source codes.
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Chapter 10

Editing features

The SpiderBasic IDE acts like any other Text Editor when it comes to the basic editing features. The
cursor keys as well as Page Up/Page Down, Home and End keys can be used to navigate through the
code. Ctrl+Home navigates to the beginning of the file and Ctrl+End to the End.

The default shortcuts Ctrl+C (copy), Ctrl+X (cut) and Ctrl+V (paste) can be used for editing. The
"Insert” key controls whether text is inserted or overwritten. The Delete key does a forward delete.
Holding down the Shift key and using the arrow keys selects text.

Furthermore, the IDE has many extra editing features specific to programming or SpiderBasic.

Indentation:

When you press enter, the indentation (number of space/tab at the beginning of the line) of the current
and next line will be automatically corrected depending on the keywords that exist on these lines. A
"block mode” is also available where the new line simply gets the same indentation as the previous one.
The details of this feature can be customized in the preferences .

Tab characters:

By default, the IDE does not insert a real tab when pressing the Tab key, as many programmers see it as
a bad thing to use real tabs in source code.

It instead inserts two spaces. This behavior can be changed in the Preferences. See Customizing the IDE
for more information.

Special Tab behavior:

When the Tab key is pressed while nothing or only a few characters are selected, the Tab key acts as
mentioned above (inserting a number of spaces, or a real tab if configured that way).

However when one or more full lines are selected, the reaction is different. In that case at the beginning
of each selected line, it will insert spaces or a tab (depending on the configuration). This increases the
indentation of the whole selected block.

Marking several lines of text and pressing Shift+Tab reverses this behavior. It removes spaces/tabs at
the start of each line in order to reduce the indentation of the whole block.

Indentation/Alignment of comments:

Similar to the special tab behavior above, the keyboard shortcuts Ctrl+E and Ctrl+4Shift+E (CMD+E
and CMD+-Shift+E on OSX) can be used to change the indentation of only the comments in a selected
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block of code. This helps in aligning comments at the end of code lines to make the code more readable.
The used shortcut can be configured in the preferences .

Selecting blocks of code:

The shortcut Ctrl+M (CMD+M on OSX) can be used to select the block of code that contains caret
position (i.e. the surrounding If block, loop or procedure). Repeated usage of the shortcut selects further
surrounding code blocks.

The shortcut Ctrl+Shift+M (CMD-+Shift+M on OSX) reverses the behavior and reverts the selection to
the block that was selected before the last usage of the Ctrl+M shortcut.

The used shortcuts can be configured in the preferences .

Double-clicking on source text:

Double-clicking on a word selects the whole word as usual. However in some cases, double-clicking has a
special meaning:

When double-clicking on the name of a procedure that is defined in the current source while holding
down the Ctrl Key, the cursor automatically jumps to the declaration of this procedure.

When double-clicking on an IncludeFile or XincludeFile statement, the IDE will try to open that file.
(This is only possible if the included file is written as a literal string, and not through for example a
constant.)

In the same way, if you double-click on an IncludeBinary statement, the IDE will try to display that file
in the internal file viewer .

Marking of matching Braces and Keywords:

; Enable the 'Stop' gadget
; Disable the 'Play' Gadget

; Enable the 'Play’ gadget
; Disable the 'Stop' Gadget

GetGadgetText(4)) ; Get the current item

Endselect

When the cursor is on an opening or closing brace the IDE will highlight the other brace that matches
it. If a matching brace could not be found (which is a syntax error in SpiderBasic) the IDE will highlight
the current brace in red. This same concept is applied to keywords. If the cursor is on a Keyword such
as "If”, the IDE will underline this keyword and all keywords that belong to it such as "Else” or "EndIf”.
If there is a mismatch in the keywords it will be underlined in red. The "Goto matching Keyword” menu
entry described below can be used to quickly move between the matching keywords.

The brace and keyword matching can be configured in the Preferences .

Command help in the status bar:

ButtonGadget(#Gadget, x vy, Width, Height, Text5 [, Flags]) - Create a button gadget in the current GadgetList.

While typing, the IDE will show the needed parameters for any SpiderBasic function whose parameters
you are currently typing. This makes it easy to see any more parameters you still have to add to this

19



function. This also works for procedures , prototypes or interfaces in your code as long as they are
declared in the same source code or project .

Folding options:

Procedure GadgetEvents()

Procedure ClosellindowEve
CloseWindow(EventWindow

EndProcedure

When special folding keywords are encountered (Procedure / EndProcedure by default. More can be
added), the IDE marks the region between these keywords on the left side next to the line numbers with
a [-] at the starting point, followed by a vertical line to the end point.

By clicking on the [-], you can hide ("fold”) that section of source code to keep a better overview of larger
source files. The [-] will turn into a [+]. By clicking again, the code will again be shown ("unfolded”)
again.

Note: Even though the state of these folded code lines is remembered when you save/reopen the file, the
actual created code file always contains all lines. This only affects the display of the code in the IDE, not
the code itself.

Another default fold keyword is 7;{” and ”;}”. Since ”;” marks a comment in PB, these will be totally
ignored by the compiler. However, they provide the possibility to place custom fold points that do not
correspond to a specific PB keyword.

Auto complete:

OpenGadget List
OpenScreen
OpenSubMenu
OpenWindow
OpenWindowedScreen

So that you do not have to remember the exact name of every command, there is the Auto complete
feature to make things easier.

After you have typed the beginning of a command, a list of possible matches to the word start you have
just typed will be displayed. A list of options is also displayed when you typed a structured variable or
interface followed by a ”\”.

You can then select one of these words with the up/down keys and insert it at the point you are by
pressing the Tab key. You can also continue typing while the list is open. It will select the first match
that is still possible after what you typed, and close automatically when either you have just typed an
exact match or if there are no more possible matches in the list.

Escape closes the auto complete list at any time. It also closes if you click with the mouse anywhere
within the IDE.

Note: You can configure what is displayed in the Auto complete list, as well as turning off the automatic
popup (requiring a keyboard shortcut such as Ctrl+Space to open list) in the Preferences. See the Auto
complete section of Customizing the IDE for more information.
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Tools Panel on the side:

Procedures | Project | Explorer

GadgetEvents
CloseWindowEvent

Many tools to make navigating/editing the source code easier can be added to the Tools Panel on the
side of the editor window. For an overview of them and how to configure them, see Built-in Tools .

The Edit Menu:

Following is an explanation of the Items in the Edit menu. Note that many of the Edit menu items are
also accessible by right clicking on the source code, which opens a popup menu.

= Undo Ctrl+Z
Z Redo Ctrl+Y
a Cut Ctrl+X
[ Copy Ctrl+C
[ Paste Ctrl+V
Cd Insert comments Ctrl+B
Ld Remove comments Ctrl+Shift+B
= Format indentation Ctrl+I

Select All Ctri+A
% Goto.. Ctrl+G
4% Goto matching Keyword Ctrl+K
g Goto recent Line Ctrl+L

Toggle current fold F4

Toggle all folds Ctrl+F4
& Add/Remove Marker Ctrl+F2
42 Jump to Marker F2

Clear Markers

#8 Find/Replace... Ctrl+F
# Find Mext F3

# Find in Files... Ctrl+5Shift+F
Undo

Undoes the last done action in the code editing area. There is an undo buffer, so several actions can be
undone.

Redo

Redo the last action undone by the undo function.

Cut

Copy the selected part of the source code to the clipboard and remove it from the code.

Copy

Copy the selected text to the Clipboard without deleting it from the code.
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Paste

Insert the content of the Clipboard at the current position in the code. If any text is selected before this,
it will be removed and replaced with the content of the Clipboard.

Insert comments

Inserts a comment (”;”) before every line of the selected code block. This makes commenting large blocks
of code easier than putting the ; before each line manually.

Remove comments

Removes the comment characters at the beginning of each selected line. This reverts the "Insert
comments” command, but also works on comments manually set.

Format indentation

Reformats the indentation of the selected lines to align with the code above them and to reflect the
keywords that they contain. The rules for the indentation can be specified in the preferences .

Select all Selects the whole source code.

Goto

This lets you jump to a specific line in your source code.

Goto matching Keyword

If the cursor is currently on a keyword such as "If” this menu option jumps directly to the keyword that
matches it (in this case "EndIf”).

Goto recent line

The IDE keeps track of the lines you view. For example if you switch to a different line with the above
Goto function, or with the Procedure Browser tool. With this menu option you can jump back to the
previous position. 20 such past cursor positions are remembered.

Note that this only records greater jumps in the code. Not if you just move up/down a few lines with
the cursor keys.

Toggle current fold

This opens/closes the fold point in which the cursor is currently located.

Toggle all Folds

This opens/closes all fold points in the current source. Very useful to for example hide all procedures in
the code. Or to quickly see the whole code again when some of the code is folded.

Add/Remove Marker

Markers act like Bookmarks in the source code. There presence is indicated by a little arrow next to the
line numbers. You can later jump to these markers with the "Jump to marker” command.

The ”Add/Remove Marker” sets or removes a marker from the current line you are editing.

Note: You can also set/remove markers by holding down the Ctrl Key and clicking on the border that
holds the markers (not the Line-number part of it).

Jump to Marker

This makes the cursor jump to the next marker position further down the code from the current cursor
position. If there is no marker after the cursor position, it jumps to the first on in the source code. So by
pressing the ”Jump to Marker” shortcut (F2 by default) several times, you can jump to all the markers
in the code.

Clear Markers This removes all markers from the current source code.

Find/Replace

Search for: |Indm(l

] Replace with:

[]Case Senstive [ ] Dont search in Comments
[ ] Whole Wards only [ ] Dont search in Strings

Search inside Selection anly

Find Nexdt Replace Replace All

The find/replace dialog enables you to search for specific words in your code, and also to replace them
with something else.

The "Find Next” button starts the search. The search can be continued after a match is found with the
Find Next menu command (F3 by default).

You can make the search more specific by enabling one of the checkboxes:
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Case Sensitive : Only text that matches the exact case of the search word will be found.

Whole Words only : Search for the given word as a whole word. Do not display results where the search
word is part of another word.

Don’t search in Comments : Any match that is found inside a comment is ignored.

Don’t search in Strings : Any match that is found inside a literal string (in ” ”) is ignored.

Search inside Selection only : Searches only the selected region of code. This is really useful only
together with the "Replace All” button, in which case it will replace any found match, but only inside
the selected region.

By enabling the "Replace with” checkbox, you go into replace mode. "Find Next” will still only search,
but with each click on the "Replace” button, the next match of the search word will be replaced by
whatever is inside the "Replace with” box.

By clicking on "Replace All”, all matches from the current position downwards will be replaced (unless
"Search inside Selection only” is set).

Find Next

This continues the search for the next match of the last search started by the Find/Replace dialog.
Find in Files

Search for: | DataSection

Root directory: ||

Extension fiters: | *sh

[]Case Sensiive [] Don't search in Commerts
[]Whole Words only [] Dont search in Strings
[ Include sub-directories

Start Stop

The Find in Files Dialog lets you carry out a search inside many files in a specific directory.

You have to specify a search keyword, as well as a base directory ("root directory”) in which to search.
You can customize the searched files by specifying extension filters. Any number of filters can be given
separated by ”,”. (*.* or an empty extension field searches all files). As with "Find/Replace”, there are
checkboxes to make the search more specific.

The "Include sub-directories” checkbox makes it search (recursively) inside any subdirectory of the given
root directory too.

When starting the search, a separate window will be opened displaying the search results, giving the file,
line number as well as the matched line of each result.

Double-clicking on an entry in the result window opens that file in the IDE and jumps to the selected
result line.
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Chapter 11
Managing projects

The IDE comes with features to easily handle larger projects. These features are completely optional.
Programs can be created and compiled without making use of the project management. However, once a
program consists of a number of source code and maybe other related files, it can be simpler to handle
them all in one project.

Project management overview

A project allows the management of multiple source codes and other related files in one place with quick
access to the files through the project tool . Source files included in a project can be scanned for
AutoComplete even if they are not currently open in the IDE. This way functions, constants, variables
etc. from the entire project can be used with AutoComplete. The project can also remember the source
files that are open when the project is closed and reopen them the next time to continue working exactly
where you left off.

Furthermore, a project keeps all the compiler settings in one place (the project file) and even allows to
manage multiple "compile targets” per project. A compile target is just a set of compiler options. This
way multiple versions of the same program, or multiple smaller programs in one project can be easily
compiled at once.

To compile a project from a script or makefile, the IDE provides command-line options to compile a
project without opening a user interface. See the section on command-line options for more details.

All filenames and paths in a project are stored relative to the project file which allows a project to be
easily moved to another location as long as the relative directory structure remains intact.

The Project menu

New Project... Ctrl+Shift+N

Ld Open Project... Ctrl+Shift+0
Recent Projects »
Close Project Ctrl+Shift+W

[E Project Options...

[.) Add File to Project Ctrl+Shift+A

[ Remove File from Project Ctrl+5Shift+R

., Open Project Folder

New Project
Creates a new project. If there is a project open at the time it will be closed. The project options
window will be opened where the project filename has to be specified and the project can be configured.
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Open Project

Opens an existing project. If there is a project open at the time it will be closed. Previously open source
codes of the project will be opened as well, depending on the project configuration.

Recent Projects

This submenu shows a list of recently opened project files. Selecting one of the entries opens this project.
Close Project

Closes the currently open project. The settings will be saved and the currently open source files of the
project will be closed, depending on the project configuration.

Project Options

Opens the project options window. See below for more information.

Add File to Project

Adds the currently active source code to the current project. Files belonging to the project are marked
with a ”>" in the file panel.

Remove File from Project

Removes the currently active source from the current project.

Open Project folder

Opens the folder that contains the project file in whatever file manager is available on the system.

The project options window

The project options window is the central configuration for the project. The general project settings as
well as the settings for the individual files in the project can me made here.

Project Options | Project Files
Project Info
Project File: C:\PureBasichSvn'w5.40"Build"SpiderBasic_x26"Test Project sbp
Project Name: | 2DDrawing|
Comments:

Loading Options
[ ] 5et as defautt project (zlways open when the |DE starts)
Close all sources when closing the project

When opening the project...

(®) load all sources that were open last time
(_)load all sources of the project

(_)load only sources marked in "Project Files®

(_)load only the main file of the default target
i

) load no files

Compiler Options

The following settings can be made on the "Project Options” tab:

Project File

Shows the filename of the project file. This can only be changed during project creation.

Project Name

The name of the project. This name is displayed in the IDE title bar and in the "Recent Projects” menu.
Comments

This field allows to add some comments to the project. They will be displayed in the project info tab.
Set as default project

The default project will be loaded on every start of the IDE. Only one project can be the default project
at a time. If there is no default project, the IDE will load the project that was open when the IDE was
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closed last time if there was one.

Close all sources when closing the project

If enabled, all sources that belong to the project will be closed automatically when the project is closed.
When opening the project...

load all sources that where open last time

When the project is opened, all the sources that were open when the project was closed will
be opened again.

load all sources of the project

When the project is opened, all (source-)files of the project will be opened.

load only sources marked in 'Project Files’

When the project is opened, only the files that are marked in the 'Project Files’ tab will be
opened. This way you can start a session always with this set of files open.

load only the main file of the default target

When the project is opened, the main file of the default target will be opened too.

load no files

No source files are opened when the project is opened.

The "Project Files” tabs shows the list of files in the project on the right and allows changing their
settings. The explorer on the left is for the selection of new files to be added.

Project Files

|1. Bxamples | MNew || Open | Wiew

MNom File

k. C:\AMDMSpiderBasic1.00"Examples*20 Drawing sb
. Data
1. Waponez Web
71 2DDrawing b
mCEIHVEISGEIdgE‘LSb
i3l Date.sb
7l Gadget sb
mGadge‘tO\rewiew.sb
[Tl Http.sb
07 InlinedJS sb
7! Keyboard sb
m Map.sb
m Memary sb
m Menu.sb
m Mouse sb
A NinenFile Ren ester ch

| SpiderBasic Files (*sb, *sbi, *sb

o ]|

Load file when opening the project Scan file for Autocomplete

W

Display a waming i file changed Show file in the Project panel

The buttons on the top have the following function:

Add

Add the selected file(s) in the explorer to the project.

Remove

Remove the selected files in the file list from the project.

New

Shows a file requester to select a filename for a new source file to create. The new file will be
created, opened in the IDE and also added to the project.

Open

Shows a file requester to select an existing file to open. The file will be opened in the IDE
and added to the project.

26



View
Opens the selected file(s) in the file list in the IDE or if they are binary files in the FileViewer.

The checkboxes on the bottom specify the options for the files in the project. They can be applied to a
single file or to multiple files at once by selecting the files and changing the state of the checkboxes. The

settings have the following meaning:

Load file when opening the project

Files with this option will be loaded when the project is open and the ”load only sources
marked in 'Project Files”’ option is specified on the "Project Options” tab.

Display a warning if file changed

When the project is closed, the IDE will calculate a checksum of all files that have this
option set and display a warning if the file has been modified when the project is opened the
next time. This allows to be notified when a file that is shared between multiple projects has
been edited while working on another project. This option should be disabled for large data
files to speed up project loading and saving, or for files which are changed frequently to avoid
getting a warning every time the project is opened.

Scan file for AutoComplete

Files with this option will be scanned for AutoComplete data even when they are not
currently loaded in the IDE. This option is on by default for all non-binary files. It should be
turned off for all files that do not contain source code as well as for any files where you do
not want the items to turn up in the AutoComplete list.

Show file in Project panel

Files with this option will be displayed in the project side-panel. If the project has many files
it may make sense to hide some of them from the panel to have a better overview and faster
access to the important files in the project.

The project overview

When a project is open, the first tab of the file panel shows an overview of the project and its files.

A Project X 2DDrawingsb X M
Project Info
Project Mame: Mew Project : ;
Project File: C:\PureBasichSvn'w5.40MBuild"SpiderBasic_xB86\TestProject sbp Riec et
Last open: 03/24/2015 - 22:00 by Fred on SUPERFROG Sl
Editor: SpiderBasic 1.00 (Windows - x86)
Project Files
Filename load Wam Scan Panel Size Last Modified
@ CMAMDNSpiderBasic1.00"Examples" 20 Drawing sb Yes Yes Yes 1.14kKb 1270672014 -
< >
Project Targets
Target Debug Unicode Thread Asm OnEmor Compile Build Format Input
» Default Target Yes Yes Windows 2DDr
< >

Project Info
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This section shows some general info about the project, such as the project filename, its comments or
when and where the project was last opened.

Project Files

This section shows all files in the project and their settings from the Project Options window.
Double-clicking on one of the files opens the file in the IDE. Right-clicking displays a context menu with
further options:

I Open
= Open in FileViewer
., Open in Explorer

[ Add file to Project...
[.d Remove from Project
2

Refresh AutoComplete data

Open - Open the file in the IDE.

Open in FileViewer - Open the file in the FileViewer of the IDE.

Open in Explorer - Open the file in the operating systems file manager.
Add File to Project - Add a new file to the project.

Remove File from Project - Remove the selected file(s) from the project.
Refresh AutoComplete data - Rescan the file for AutoComplete items.

Project Targets

This section shows all compile targets in the project and some of their settings. Double-clicking on one
of the targets opens this target in the compiler options . Right-clicking on one of the targets displays a
context menu with further options:

Edit target - Open the target in the compiler options.

Set as default target - Set this target as the default target.

Enable in ’Build all Targets’ - Include this target in the ’Build all Targets’ compiler menu
option.

The project panel

There is a sidepanel tool which allows quick access to the files belonging to the project. For more
information see the built-in tools section.
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Chapter 12
Compiling your programs

Compiling is easy. Just select "Compile/Run” (F5 by default) and your program will be compiled and
launched in the default web browser.

To customize the compiling process, you can open the "Compiler options” dialog. The settings made
there are associated with the current source file or the current project, and also remembered when they
are closed. The place where this information is saved can be configured. By default, it is saved at the
end of the source code as a comment (invisible in the IDE).

In case of an error that prevents the compiler from completing the compilation, it aborts and displays an
error-message. This message is also logged in the error log, and the line that caused the error is marked.
A number of functions from older versions of SpiderBasic that have been removed from the package still
exist for a while as a compatibility wrapper to allow older codes to be tested/ported more easily. If such
a function is used in the code, the compiler will issue a warning. A window will be opened displaying all
warnings issued during compilation. Double-clicking on a warning will display the file/line that caused
the warning. Note that such compatibility wrappers will not remain indefinitely but will be removed in a
future update, so it is recommended to fix issues that cause a compiler warning instead of relying on
such deprecated functions.

The compiler menu

. Compile/Run F5
Syntax check

‘% Compile with Debugger
‘@ Compile without Debugger

%, Restart Compiler

¢ Compiler Options...

Create App...

Set default Target 4

Build Target 4

Build all Targets
Compile/Run

This compiles the current source code with the compiler options set for it and executes it. The
executable file is stored in a temporary location, but it will be executed with the current path set to the
directory of the source code; so loading a file from the same directory as the source code will work.

The source code need not be saved for this (but any included files must be saved).

The ”"Compile/Run” option respects the debugger setting (on or off) from the compiler options or
debugger menu (they are the same).

Run

This executes the last compiled source code once again. Whether or not the debugger is enabled depends
on the setting of the last compilation.

Compile with Debugger

This is the same as "Compile/Run” except that it ignores the debugger setting and enabled the debugger
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for this compilation. This is useful when you usually have the debugger off, but want to have it on for
just this one compilation.

Compile without Debugger

Same as "Compile with Debugger” except that it forces the debugger to be off for this compilation.
Restart Compiler (not present on all OS)

This causes the compiler to restart. It also causes the compiler to reload all the libraries and resident
files, and with that, the list of known SpiderBasic functions, Structures, Interfaces and Constants is
updated too. This function is useful when you have added a new User Library to the PB directory, but
do not want to restart the whole IDE. It is especially useful for library developers to test their library.
Compiler Options

This opens the compiler options dialog, that lets you set the options for the compilation of this source
file.

Export

Launch the export process. The export settings can be changed in the "Compiler Options/Export” panel.
Set default Target

When a project is open, this submenu shows all compile targets and allows to quickly switch the current
default target. The default target is the one which is compiled/executed with the "Compile/Run” menu
entry.

Build Target

When a project is open, this submenu shows all compile targets and allows to directly compile one of
them.

Build all Targets

When a project is open, this menu entry compiles all targets that have this option enabled in the
compiler options. A window is opened to show the build progress.

Compiler options for non-project files

Compiler Options | Compile/Fun | Export | Constants

[ Main source file:

[ Use Compiler: SpiderBasic 1.02 (Windows - x86)
[]Use lcon:

[ Optimize javascript output

Library Subsystem:

Main source file

By enabling this option, you can define another file that will be the one sent to the compiler instead of
this one. The use of this is that when you are editing a file that does not run by itself, but is included
into another file, you can tell the compiler to use that other file to start the compilation.

Note: When using this option, you MUST save your source before compiling, as only files that are
written to disk will be used in this case. Most of the compiler settings will be taken from the main
source file, so when setting this, they are disabled. Only some settings like the debugger setting will be
used from the current source.

Use Compiler

This option allows the selection of a different compiler to use instead of the compiler of the current
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SpiderBasic version. This makes it easy to compile different versions of the same program (x86 and x64
or PowerPC) without having to start up the IDE for the other compiler just for the compilation.
Additional compilers for this option have to be configured in the preferences .

If the compiler version matches that of the default compiler but the target processor is different then the
built-in debugger of the IDE can still be used to debug the compiled executable. This means that an
executable compiled with the x86 compiler can be debugged using the x64 IDE and vice versa on
Windows and Linux. The same applies to the x86 and PowerPC compilers for Mac OSX. This is
especially useful as this way the fast x86 IDE and debugger can be used on a Mac with an Intel
processor while still compiling programs for the PowerPC processor through the slower emulation. If the
version does not match then the standalone debugger that comes with the selected compiler will be used
for debugging to avoid version conflicts.

Use icon

When enabled, allow to set the "favicon” file for the web application. The icon has to be in the PNG
image format. This icon is usually displayed in the browser tab, near the page title.

Enable DPI Aware application

This option enable DPI awareness when creating an application. That means than the canvas and
images created in SpiderBasic will scale automatically if the DPI of the screen is above 100%. The
functions can be used to detect which scale is currently applied when this option is enabled.

Optimize JavaScript output

When enabled, uses the Google JavaScript closure compiler to optimize the generated JavaScript code to
reduce its size. A recent Java JRE needs to be installed to have this option working. The most recent
JRE version can be found here: https://java.com/download.

Library Subsystem

Here you can select different subsystems for compilation. More than one subsystem can be specified,
separated with space character. For more information, see subsystems .

Compile/Run

This section contains options that affect how the executable is run from the IDE for testing. Except for
the tools option, they have no effect when the "Create executable” menu is used.

Compiler Options | Compile/Run | Export | Constarts

Debugger:
Enable Debugger

Web serverport: (9630

Execute tools:

Name Trigger Global setting

Enable Debugger

This sets the debugger state (on/off) for this source code, or if the main file option is used, for that file
too. This can also be set from the debugger menu.

Web server address

This allows to set a specific web server address for this file or project. The value has to be specified as
"address:port’ (example: "localhost:8080” or 'mydomain:80’). If set to an empty value, localhost will be
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used with a random dynamic port, starting from the value set in Preferences/Compiler.

Execute tools

Here external tools can be enabled on a per-source basis. The "Global settings” column shows if the tool
is enabled or disabled in the tools configuration . A tool will only be executed for the source if it is both
enabled globally and for this source.

Note: For a tool to be listed here, it must have the "Enable Tool on a per-source basis” option checked in
the tools configuration and be executed by a trigger that is associated with a source file (i.e. not
executed by menu or by editor startup for example).

Constants

In this section, a set of special editor constants as well as custom constants can be defined which will be
predefined when compiling this source.

Compiler Options | Compile/Run | Export | Constants

Editor constants:

[]#PE_Edtor_ CompileCourt:

[ ]#PE_Edtor_BuildCount:

[ ]#PE_Edtor CreateExecutable

Customn constants:

#PB _Editor CompileCount

If enabled, this constant holds the number of times that the code was compiled (both with
"Compile/Run” and ”Create Executable”) from the IDE. The counter can be manually edited in the
input field.

#PB_Editor BuildCount

If enabled, this constant holds the number of times that the code was compiled with "Create Executable”
only. The counter can be manually edited in the input field.

#PB _Editor CreateExecutable

If enabled, this constants holds a value of 1 if the code is compiled with the "Create Executable” menu or
0 if "Compile/Run” was used.

Custom constants

Here, custom constants can be defined and then easily switched on/off through checkboxes. Constant
definitions should be added as they would be written within the source code. This provides a way to
enable/disable certain features in a program by defining a constant here and then checking in the source
for it to enable/disable the features with CompilerIf/CompilerEndIf .

Inside the definition of these constants, environment variables can be used by specifying them in a
"bash” like style with a ”$” in front. The environment variable will be replaced in the constant definition
before compiling the source. This allows to pass certain options of the system that the code is compiled
on to the program in the form of constants.

Example: #Creator="$USERNAME”

Here, the SUSERNAME will be replaced by the username of the logged in user on Windows systems. If
an environment variable does not exist, it will be replaced by an empty string.

Note: To test within the source code if a constant is defined or not, the Defined() compiler function can
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be used.

Compiler options for projects

E' 4 1 1 | CompierOptions | Compie/Run | Eqort | Constants

Input source file: |2DDIEI'|\"iI"Ig.5b|

Compile targets
. Default Tanget

[ Use Compiler: SpiderBasic 1.02 (Windows - x86)
[JUse lcon:

[ Optimize javascript output

Library Subsystem:

| Set as default tanget
Enable in "Build all Targets®

The compiler options for projects allow the definition of multiple compile targets. Each target is
basically a set of compiler options with a designated source file and output executable. The left side of
the compiler options window is extended with the list of the defined compile targets. The toolbar on top
of it allows to create, delete, copy, edit or move targets in the list.

The default target is the one which will be compiled when the "Compile/Run” menu entry is selected. It
can be quickly switched with the "Set as default target” checkbox or from the compiler menu. The
“Enable in ’Build all Targets”’ option specifies whether or not the selected target will be built when the
"Build all Targets’ menu entry is used.

The right side of the compiler options is almost the same as in the non-project mode and reflects the
settings for the compile target that is currently selected on the left. The only difference is the "Input
source file” on the first tab. This fields has to be specified for all compile targets. Other than that, the
compiler options are identical to the options described above.

In project mode, the information about the compile target is stored in the project file and not in the
individual source files. Information that belongs to the file (such as the folding state) are still saved for
the individual source files in the location specified by the Preferences .
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The Build progress window

Progress

Compile targets
&) Default Target

Log

Building 'Default Targest'. ..

Compilation successful.

1 target=z compiled successfullwy.

When the 'Build all Targets’ menu entry is selected on an open project, all targets that have the
corresponding option set in the compiler options will be compiled in the order they are defined in the
compiler options. The progress window shows the current compile progress as well as the status of each
target. When the process is finished, the build log can be copied to the clipboard or saved to disk.
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Chapter 13

Using the built-in Tools

The SpiderBasic IDE comes with many building tools, to make programming tasks easier and increase
your productivity. Many of them can be configured to be either accessible from the Menu as separate
windows, or to be permanently displayed in the Panel on the side of the editing area.

For information on how to configure these tools and where they are displayed, see Configuring the IDE .

Tools for the Side Panel Area

WebView

Explorer Project Procedures WebView

‘ http://127.0.0.1 :9090/Sp\'derBasic7C0mp\'lat\'nns.htm‘ @

+ Brush
Line
Box

Circle

Clear

This tool displays and internal web browser to launch the SpiderBasic programs directly in the IDE.
When the web view is enabled, the debugger automatically connect to it and the errors are directly
reported in the IDE, on the correct file and line.

The ’earth’ button is available to open the program into the default web browser.

The ’Kill Program’ button (red cross in the toolbar) can be used to reset the web view content and stop
the SpiderBasic program. Procedure Browser
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Procedures | Project | Explorer | Help

AddBullet

Sprite PoeelCollision_2
MawveFlayers
DisplayBullets
MewAlienWave
DisplayMiens
DisplayExplosions
CheckCollisions
RenderFrame
Start

Loading
LoadingEmmor

This tool displays a list of all procedures and macros declared in the current source code. By
double-clicking on an entry in that list, the cursor automatically jumps to that procedure.

Macros will be marked in the list by a ”+” sign before the name.

You can also place special comment marks in your code, that will be displayed in the list too. They look
like this: ”;- <description>”. The ; starts a comment, the - that follows it immediately defines such a
mark.

The description will be shown in the Procedure list, and clicking on it will jump to the line of this mark.
Such a comment mark can be distinguished from a Procedure by the ”> ” that is displayed before it in
the procedure list.

The list of procedures can be sorted, and it can display the procedure/macro arguments in the list. For
these options, see Configuring the IDE .

Project Panel

Procedurss | Project | Explorer | Help

(=5 Bdtemal Files
- CAAMDNSpiderBasic1.00\Exampl,

This tool displays a tree of all files in the current project . A double-click on a file opens it in the IDE.
This allows fast access to all files in the project. A right-click on a file opens a context menu which
provides more options:

I Open
= Open in FileViewer
., Open in Explorer

[.] Add file to Project...
[.d Remove from Project
>

Refresh AutoComplete data

Open - Open the file in the IDE.

Open in FileViewer - Open the file in the FileViewer of the IDE.

Open in Explorer - Open the file in the operating systems file manager.
Add File to Project - Add a new file to the project.

Remove File from Project - Remove the selected file(s) from the project.
Refresh AutoComplete data - Rescan the file for AutoComplete items.

Explorer
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Eoionr

SpiderBasic Files (*.sb, *sbi, “sbp, “sbf)

Nom 2

M.
. Data

1. Waponez Web
71 2DDrawing sb
mCanvasGadget.sb
[Tl Date sb
i3] Gadget sb
mGadge{C)veMew.sb
i3I Hitp sb
[Tl inlinedJs sb
i3] Keyboard sb
m Map sb
m Memoary sb
m Menu sb
m Mouse sb
ﬂOpenHleHequester.sb

The Explorer tool displays an explorer, from which you can select files and open them quickly with a
double-click. SpiderBasic files (*.sb, *.sbi, *.sbp, *.sbf) will be loaded into the edit area and all other
recognized files (text & binary) files will be displayed into the internal File Viewer.

Variable Viewer

| Variables

AlienDelay
BackX

BackY

Boss

Bullet Delay
BulletSpeed
Dead
DeadDelay
EnableJoystick
Fire

ke
Paths
PlayerHeight
Playerimage
FlayerSpeedX
PlayerSpeed
PlayerWidth
Playerx
Plawvery

[ 5tay on Top

The variable viewer can display variables , Arrays , lists , Constants , Structures and Interfaces defined
in your source code, or any currently opened file. You can configure what exactly it should display in the
preferences .

Note: The displaying of variables is somewhat limited for now. It can only detect variables explicitly
declared with Define , Global , Shared , Protected or Static .

Code Templates
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o
%/ |9] |@)[x] = [1] 8

; f"‘f) Simple window

w0 Simple 20 game

[ Stay on Top

The templates tool allows you to manage a list of small code parts, that you can quickly insert into your
source code with a double-click. It allows you to manage the codes in different directories, and put a
comment to each code. This tool is perfect to manage small, often used code parts.

Issue Browser

|-‘j.3§-' Al issues

lzsue Text Line File:

Zj Fome  FIXME: Removethe.. 12 CHAMDMSpiderBasi...
@Todo TODO: Translate it 1A CHAMDNSpiderBasi...

[ Stay on Top

The issue browser tool collects comments in the source code that fit a defined format and lists them
ordered by priority. It can be used to track which areas of the source code still need to be worked on.
Each displayed issue corresponds to one comment in the code. A double-click on the issue shows that
code line. Issues can be displayed for the current file, or for multiple files (all open files, or all files that
belong to the current project ). The issue list can also be exported in CSV format.

To configure the collected issues, see the "Issues” section in the Preferences .

Color Picker
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HSV H5L Wheel Palette Name

[ Include alpha channel

2114 H: 273

: |75 5|32

1146 L: |43
£924R72

Insert Colar Ingert RGE Sawe Colar

I
I o

[ 5tay on Top

The color picker helps you to find the perfect color value for whatever task you need. The following
methods of picking a color are available:

RGB: Select a color by choosing red, green and blue intensities.

HSV: Select a color by choosing hue, saturation and value.

HSL: Select a color by choosing hue, saturation and lightness.

Wheel: Select a color using the HSV model in a color wheel.

Palette: Select a color from a predefined palette.

Name: Select a color from a palette by name.

The color selection includes an alpha component, if the "Include alpha channel” checkbox is activated.
The individual components (red/green/blue intensities or hue/saturation/lightness) as well as the
hexadecimal representation of the current color can be seen and modified in the text fields.

The "Insert Color” button inserts the hexadecimal value of the current color in the source code. The
"Insert RGB” button inserts the color as a call to the RGB() or RGBA() function into the code. The
"Save Color” button saves the current color to the history area at the bottom. Clicking on a color in the
history makes it the current color again.

Ascii Table
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| Char ”

[ 5tay on Top

The Ascii table tool displays a table showing all the Ascii characters, together with their index in
decimal and hex, as well as the corresponding html notation. By double-clicking on any line, this
character will be inserted into the source code. With the buttons on the bottom, you can select which
column of the table to insert on a double-click.

Help Tool

| Procedures I Project I E:plorerl Help |

[=]l=]la)

OpenWindow() o

Syntax

Result = OpenWindow({#Window, x, v,
InnerWidth, InnerHeight, Title$ [, Flags [,
ParentWindowlD]]}

Description

Opens a new window according to the
specified parameters. The new window
becomes the active window, it's not needed

to use SetActiveWindow() (unless the

window is created as invisible).

Parameters
#indow A number to identify the new winc
Xy The initial position of the window,
InnerkVidth, The required client area, in pixels
InnerHeight v
Ti#l~T Tha +itla af tha o araatad sine
<

The Help Tool is an alternative viewer for the reference guide . It can be used to view the SpiderBasic
manual side by side with the code. Whether or not the F1 shortcut opens the manual in the tool or as a
separate window can be specified in the preferences .
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Other built-in tools

Structure Viewer

Structures | Interfaces | Constants

EIIIIIEI [F]a
flafrls] T fu]lv

Ascii

Byte
Character
Double
DragDataFormat
Float
Integer
Long
Quad
String
Unicode
Word

Back

Stay on top Insert name Insert copy

Inzert

The structure viewer allows you to view all the Structures, Interfaces and Constants predefined in
SpiderBasic. Double-clicking on a Structure or Interface shows the declaration. On top of the list you
can select a filter to display only entries that start with a given character.

The "Back” button navigates back through the viewed entries.

"Insert name” inserts just the name of the selected entry.

"Insert copy” inserts a copy of the declaration of that entry.

"Insert” lets you enter a variable name and then inserts a definition of that variable and the selected
entry and all elements of it.

File Viewer
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] File Viewer

0 g| = =

Diablo JPG | Fockstar_Logo_Wallpaper_ywt2 jpa

£ >

Ch\Users\Fred\Pictures\Rockstar_Loge_Wallpaper__yvtd,jpg

The internal file viewer allows you do display certain types of files. Text files, images and web pages
(windows only). Any unknown file type will be displayed in a hex-viewer. The "Open” button opens a
new file, the X button” closes it and the arrows can be used to navigate through the open files.

Also any binary file that you attempt to open from the Explorer tool, or by double-clicking on an
IncludeBinary keyword will be displayed in this file viewer.

Compare Files/Folders

# Compare “

Fies | Directories | Options

File 1:

File 2: | C:\AMDM\SpiderBasic1.00alpha5" ExamplestGadgetOverview sb w

Compare

Cancel

This tool can compare two (text-) files or two directories and highlight their differences. The "Options”
tab can be used to ignore some differences such as spaces or upper/lowercase changes.
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I EEIERIER!

C:MAMDSpiderBasic1.00"Bamples\Gadget Dverview sb C:\AMDMSpiderBasic1.00alphas'\Examples GadgetOverview shb

O>Global ListIconl, Listviewl, Buttonl, Tr r>Global Listviewl, Buttonl, Treel

5 Debug DesktopName(@) ; Debug DesktopName(@)

Procedure AddListViewEvent()

AddGadietItemi ListViewl, 5, "Inserted

Procedure AddListViewEvent()

AddGadietItemi ListViewl, 5, "Inserted

;SetGadgetState(treel, 1)

;Debug GetGadgetState(Treel)

;Debug GetGadgetItemState(Treel, 6)

sRemoveGadgetItem(ListViewl, 2)

;ClearGadgetItems(ListViewl)

;SetGadgetItemText(ListViewl, 4, "Chan
EndProcedure

R S S S SO -

;SetGadgetState(treel, 1)

;Debug GetGadgetState(Treel)

;Debug GetGadgetItemState(Treel, 6)

s;RemoveGadgetItem(ListViewl, 2)

;ClearGadgetItems(ListViewl)

;SetGadgetItemText(ListViewl, 4, "Chan
EndProcedure

Procedure SizeWindowEvent()
ResizeGadget(®, 10, 16, WindowWidth(e)
;ResizeGadget(Buttonl, 1@, 18, Windowh

EndProcedure

Procedure SizeWindowEvent()
ResizeGadget (@, 1@, 16, Windowlidth(e)
;ResizeGadget(Buttonl, 18, 18, Windowh

EndProcedure

EEEREE T N S I S A e e i ST S S S Y e R )
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The files are shown side by side with the differences marked in the following way: Lines shown in red
were removed in the file on the right, lines shown in green were added in the file on the right and lines
shown in yellow were changed between the two files.

= BE=2 (821 1

Directory 1: C:A\AMD"SpiderBasic1.00Eamples'.
Directory 2: C:\AMD"SpiderBasic1.00alphad"\Eamples®.

Filename Status Date in (1)

L l2DDawingsb | Modfied | 12/D5/201412:38 07/31/2014 11:11

£ CanvasGadget sb Modfied 12/07/2014 14:00 02/19/20714 18:44

2] Datesh Modfied 12/03/2014 17:49 01/19/2014 13:40

=] Gadget sb Modfied 03/25/2015 10:18 02/02/2014 23:04
| GadgetOverview sb Unchanged 05/02/2014 13:03 05/02/2014 13:03

When comparing directories, the content of both directories is examined (with the option to filter the
search by file extension and include subdirectories) and the files are marked in a similar way: Files in red
do not exist in the second directory, files in green are new in the second directory and files in yellow were
modified. A double-click on a modified file shows the modifications made to that file.
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Chapter 14

Using external tools

The SpiderBasic IDE allows you to configure external programs to be called directly from the IDE,
through the Menu, Shortcuts, the Toolbar, or on special “triggers”. The use of this is to make any other
program you use while programming easily accessible.

You can also write your own little tools in SpiderBasic that will perform special actions on the source
code you are currently viewing to automate common tasks. Furthermore, you can configure external file
viewers to replace the internal File Viewer of the IDE for either specific file types or all files.

Color Picker
Asdii Table Alt+A

W Configure Tools...

With the "Config tools” command in the Tools menu, you can configure such external tools. The list you
will see displays all the configured tools in the order they appear in the Tools menu (if not hidden). You
can add and remove tools here, or change the order by clicking "Move Up”/”Move Down ” after selecting
an item.

Name Trigger Commandiine

DocMaker Menu Or Shortcut DocMaker
Pure Unit Menu Or Shortcut Pure Unit

Mowve Down

Any tool can be quickly enabled or disabled from the "Config tools” window with the checkbox before
each tool entry. A checked checkbox means the tool is enabled, an unchecked one means it is currently
disabled.

Configuring a tool

The basic things you need to set is the command-line of the program to run, and a name for it in the
Tools list/Menu. Everything else is optional.
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Commandiine:

|| [ Wait until tool quits

Argumerts: []Run Hidden
Hide Editor
Working Directory: Reload Source after tool has quit
®) into new source
into cument source

[ ] Hide Tool from the Main menu

Event to trigger the tool:
Enable Tool on a persource basis
Menu Or Shortcut
Supported File extensions (ext1.ex2,.)
Shortcut:

Aucun

Command-line

Select the program name to execute here.

Arguments

Place command-line arguments that will be passed to the program here. You can place fixed options, as
well as special tokens that will be replaced when running the program:

%PATH : will be replaced with the path of the current source code. Remains empty if the source was
not saved.

%FILE : filename of the current source code. Remains empty if it has not yet been saved. If you
configure the tool to replace the file viewer, this token represents the file that is to be opened.
%TEMPFILE : When this option is given, the current source code is saved in a temporary file, and the
filename is inserted here. You may modify or delete the file at will.

%COMPILEFILE : This token is only valid for the compilation triggers (see below). This is replaced
with the temporary file that is sent to the compiler for compilation. By modifying this file, you can
actually change what will be compiled.

%EXECUTABLE : This will be replaced by the name of the executable that was created in with the last
"Create Executable”. For the "After Compile/Run” trigger, this will be replaces with the name of the
temporary executable file created by the compiler.

%CURSOR : this will be replaced by the current cursor position in the form of LINExCOLUMN.
%SELECTION : this will be replaced by the current selection in the form of
LINESTARTxCOLUMNSTARTXLINEENDxCOLUMNEND. This can be used together with
%TEMPFILE, if you want your tool to do some action based on the selected area of text.

%WORD : contains the word currently under the cursor.

%PROJECT : the full path to the directory containing the project file if a project is open.

%HOME : the full path to the spiderbasic directory

Note: for any filename or path tokens, it is generally a good idea to place them in ”” (i.e.
"%TEMPFILE”) to ensure also paths with spaces in them are passed correctly to the tool. These tokens
and a description can also be viewed by clicking the "Info” button next to the Arguments field.
Working Directory

Select a directory in which to execute this tool. By specifying no directory here, the tool will be
executed in the directory of the currently open source code.

Name

Select a name for the tool. This name will be displayed in the tools list, and if the tool is not hidden
from the menu, also in the Tools menu.

9999

Event to trigger the tool

Here you can select when the tool should be executed. Any number of tools can have the same trigger,
they will all be executed when the trigger event happens. The order of their execution depends on the
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order they appear in the tools list.

[Menu Or Shortcut - ]
Menu Or Shorteut

Editor Closing

Before Compile/Run

After Compile/Run

Run compiled Program

Before Create Executable

After Create Executable
Sourcecode loaded
Sourcecode saved

Replace Fileviewer - All files
Replace FileViewer - Unknown files
Replace FileViewer - Special file
Sourcecode closed

Mew Sourcecode created

Menu Or Shortcut

The tool will not be executed automatically. It will be run by a shortcut or from the Menu. Note: to
execute a tool from the Toolbar, you have to add a button for it in the Toolbar configuration in the
Preferences (see Configuring the IDE for more).

With this trigger set, the "Shortcut” option below becomes valid and lets you specify a shortcut that will
execute this tool.

Editor Startup

The tool will be executed right after the IDE has been fully started.

Editor End

The tool will be executed right before the IDE ends. Note that all open sources have already been closed
at this time.

Before Compile/Run

The tool will be executed right before the compiler is called to compile a source code. Using the
%COMPILEFILE token, you can get the code to be compiled and modify it. This makes it possible to
write a small pre-processor for the source code. Note that you should enable the "Wait until tool quits”
option if you want your modifications to be given to the compiler.

After Compile/Run

The tool will be executed right after the compilation is finished, but before the executable is executed for
testing. Using the %WEXECUTABLE token, you can get access to the file that has just been created.
Note that you can modify the file, but not delete it, as that results in an error-message when the IDE
tries to execute the file.

Run compiled Program

The tool will be executed when the user selects the "Run” command from the compiler menu. The tool
is executed before the executable is started. The %UEXECUTABLE token is valid here too.

Before create Executable

The same as for the "Before Compile/Run” trigger applies here too, only that the triggering event is
when the user creates the final executable.

After create Executable

The tool is executed after the compilation to create the final executable is complete. You can use the
%EXECUTABLE token to get the name of the created file and perform any further action on it.
Source code loaded

The tool is executed after a source code has been loaded into the IDE. The %FILE and %PATH tokens
are always valid here, as the file was just loaded from the disk.

Source code saved

The tool will be executed after a source code in the IDE has been saved successfully. The %FILE and
%PATH tokens are always valid here, as the file has just been saved to disk.

Source code closed

The tool will be executed whenever a source file is about to be closed. At this point the file is still there,
so you can still get its content with the % TEMPFILE token. %FILE will be empty if the file was never
saved.

File Viewer All Files

The tool will completely replace the internal file viewer. If an attempt is made in the IDE to open a file
that cannot be loaded into the edit area, the IDE will first try the tools that have a trigger set for the
specific file type, and if none is found, the file will be directed to this tool. Use the %FILE token to get
the filename of the file to be opened.

Note: Only one tool can have this trigger. Any other tools with this trigger will be ignored.
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File Viewer Unknown file

This tool basically replaces the hex viewer, which is usually used to display unknown file types. It will be
executed, when the file extension is unknown to the IDE, and if no other external tool is configured to
handle the file (if a tool is set with the "File Viewer All Files” trigger, then this tool will never be called).
Note: Only one tool can have this trigger set.

File Viewer Special file

This configures the tool to handle specific file extensions. It has a higher priority than the "File Viewer
All files” or "File Viewer Unknown file” triggers and also higher than the internal file viewer itself.
Specify the extensions that the tool should handle in the edit box on the right. Multiple extensions can
be given.

A common use for this trigger is for example to configure a program like Acrobat Reader to handle the
"pdf” extension, which enables you to easily open pdf files from the Explorer, the File Viewer, or by
double-clicking on an Includebinary statement in the source.

Other options on the right side

Wait until tool quits

The IDE will be locked for no input and cease all its actions until you tool has finished running. This
option is required if you want to modify a source code and reload it afterwards, or have it passed on to
the compiler for the compilation triggers.

Run hidden

Runs the program in invisible mode. Do not use this option for any program that might expect user
input, as there will be no way to close it in that case.

Hide editor

This is only possible with the "wait until tool quits” option set. Hides the editor while the tool is running.
Reload Source after the tool has quit

This is only possible with the ”wait until tool quits” option set, and when either the %FILE or
%TEMPFILE tokens are used in the Arguments list.

After your program has quit, the IDE will reload the source code back into the editor. You can select
whether it should replace the old code or be opened in a new code view.

Hide Tool from the Main menu

Hides the tool from the Tools menu. This is useful for tools that should only be executed by a special
trigger, but not from the menu.

Enable Tool on a per-source basis

Tools with this option set will be listed in the "Execute tools” list in the compiler options , and only
executed for sources where it is enabled there. Note that when disabling the tool with the checkbox here
in the "Config tools” window, it will be globally disabled and not run for any source code, even if enabled
there.

This option is only available for the following triggers:

- Before Compile/Run

- After Compile/Run

- Run compiled Program

- Before create Executable

- After create Executable

- Source code loaded

- Source code saved

- Source code closed

Supported File extensions

Only for the "File Viewer Special file” trigger. Enter the list of handled extensions here.

Tips for writing your own code processing tools

The IDE provides additional information for the tools in the form of environment variables.
This is a list of provided variables. Note that those that provide information about the active source are
not present for tools executed on IDE startup or end.

PB_TOOL_IDE - Full path and filename of the IDE
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PB_TOOL_Compiler - Full path and filename of the Compiler
PB_TOOL_Preferences - Full path and filename of the IDE’s Preference

file

PB_TOOL_Project - Full path and filename of the currently open
project (if any)

PB_TOOL_Language - Language currently used in the IDE

PB_TOOL_Filelist - A 1list of all open files in the IDE, separated
by Chr (10)

PB_TOOL_Debugger - These variables provide the settings from the

Compiler Options

PB_TOOL_InlineASM window for the current source. They are set to
"1" if the option
PB_TOOL_Unicode is enabled, and "O" if not.

PB_TOOL_Thread
PB_TOOL_XPSkin
PB_TOOL_OnError

PB_TOOL_SubSystem - content of the "Subsystem" field in the
compiler options
PB_TOOL_Executable - same as the %COMPILEFILE token for the
command -1line
PB_TOOL_Cursor - same as the %CURSOR token for the command-line
PB_TOOL_Selection - same as the %SELECTION token for the
command -1line
PB_TOOL_Word - same as the %WORD token for the command-line
PB_TOOL_MainWindow - 0S handle to the main IDE window
PB_TOOL_Scintilla - 0S handle to the Scintilla editing component of

the current source

When the %TEMPFILE or %COMPILEFILE tokens are used, the IDE appends the compiler options as
a comment to the end of the created temporary file, even if the user did choose to not save the options
there when saving a source code.

This enables your tool to read the compiler settings for this file, and take them into account for the
actions your carries out.
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Chapter 15

Getting Help

The SpiderBasic IDE provides ways to access the SpiderBasic help-file, as well as other files and

documentation you want to view while programming.

Quick access to the reference guide

H o« =

Masquer Frécédent  Suivant  Accueil

Imprimer

§ & &

Options

§0ITII'I'IEIiI'8| lndexl ﬂecha'merl Ea\rorisl

Introduction
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Requirements
Installation
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®
Ordering
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Acknowledgements
History
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Managing
projects

Compiling your
rograms

Built-in Tools
External Tools
Getting help

Customizing the
IDE
IDE Command-

line options

General Topics

Using the
command line
compiler

General Syntax
Rules

Variables
Types and
Operators

General Libraries

D Drawin
Arra

ate
Debugger
Deskto
Font
Gadget

ion

By pressing the help shortcut (F1 by default) or selecting the "Help...” command from the Help menu
while the mouse cursor is over a SpiderBasic keyword or function, the help will be opened directly at the
description of that keyword or function.
If the word at the cursor position has no help entry, the main reference page will be displayed.
The reference manual can also be viewed side by side with the source code using the Help Tool .
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Accessing external helpfiles from the IDE

If you have other helpfiles you wish to be able to access from the IDE, then create a "Help” subdirectory
in your SpiderBasic folder and copy them to it. These files will appear in the "External Help” submenu
of the Help menu, and in the popupmenu you get when right-clicking in the editing area. Chm and Hlp
files will be displayed in the MS help viewer. The IDE will open the helpfiles in the internal fileviewer.
So files like text files can be viewed directly like this. For other types, you can use the Config Tools
menu to configure an external tool to handle the type of help-file you use. The help will then be
displayed in that tool.

For example, if you have pdf helpfiles, configure an external tool to handle pdf files and put the files in
the Help subdirectory of SpiderBasic. Now if you click the file in the “external help” menu, it will be
opened in that external tool.
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Chapter 16

Customizing the IDE

The SpiderBasic IDE provides many options to customize or disable some of its features in order to
become the perfect tool for you.

These options are accessible from the Preferences command in the File menu, and the meaning of each
setting is described here.

Any changes made will only take effect once you click the "OK” button or "Apply”.

General

General

-Language Run only one Instance
- Shortcuts
[ ] Disable Splash Screen

Memorize Window positions

Autoreload |ast open sources

-oggtom keywords [] Display full Source Path in TitleBar

ding

Indentation
- AutoComplete

RecentFiles list size:
Search History size:

Updates
Check for updates: |Once a week

. Session History
=1+ Compiler

Check for releases: | Final releases

B ToolsPanel
. -Options
i Import/Export

Options that affect the general behavior of the IDE.

Run only one Instance

If set, prevents the IDE from being opened more than once. Clicking on a PB file in the explorer will
open it in the already existing IDE instance instead of opening a new one.

Disable Splash screen

Disables the splash screen that is displayed on start-up.

Memorize Window positions
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Remembers the position of all IDE windows when you close them. If you prefer to have all windows
open at a specific location and size, enable this option, move all windows to the perfect position, then
restart the IDE (to save all options) and then disable this option to always open all windows in the last
saved position.

Show window contents while moving the Splitter

Enable this only if you have a fast computer. Otherwise moving the Splitter bar to the Error Log or
Tools Panel may flicker a lot.

Auto-Reload last open sources

On IDE start-up, opens all the sources that were open when the IDE was closed the last time.
Display full Source Path in Title bar

If set, the IDE title bar will show the full path to the currently edited file. If not, only the filename is
shown.

Recent Files list

This setting specifies how many entries are shown in the "Recent Files” submenu of the File menu.
Search History size

This setting specifies how many recent search words are remembered for "Find /Replace” and "Find in
Files”

Check for updates

Specifies how often the IDE should check on the spiderbasic.com server for the availability of new
updates. An update check can also be performed manually at any time from the "Help” menu.
Check for releases

Specifies which kind of releases should cause a notification if they are available.

General - Language

Language
|Englsh -

Language Information:

Last Updated: 05/29/2014
Creator:  PureBasic Team
Email: support@purebasic.com

Filename: ——

This allows you to change the language of the IDE. The combo box shows the available languages, and
you can view some information about the language file (for example who translated it and when it was
last updated).

General - Shortcuts

Shortcuts

Action Shortcut it

File - New CirlsN

File -> Open. Ctl=0 3
File -> Save Cid+S

File -> Save As...

File -> Save Al

File -» Reload

File -» Close CtdsW

File -> Close All

File -» View changes

File -» Encoding: Plain Text

File -» Encoding: U8

File -> Newline: Windows (CRLF)
File -> Newline: Lirwoe (LF}

File -> Newline: MacOS (CR)

File - Preferences...

File > Session History

File -» Quit

Edit -> Undo Ctd+Z
Edit -> Redo Cid+Y i
Select shortets:  None

Here you can fully customize all the shortcut commands of the IDE. Select an entry from the list, select
the shortcut field, enter the new key combination and click "Set” to change the entry.
Note that Tab & Shift+Tab are reserved for block-indentation and un-indentation and cannot be
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changed. Furthermore some key combination might have a special meaning for the OS and should
therefore not be used.

General - Themes

Themes

O EeHEFomRRRRREIPEQ

PureBasic defautt theme
Created by Gary Willoughby (Kale)

o COEHRERR=F/Eaes DR
Based on the Silk icon set’ by Mark James
hittp ./ Aananes Famfamfam .com/abAcons/silk/

Display lcons in the Menu
Show main Toolbar

This section shows the available icon themes for the IDE and allows to select the theme to use. The IDE
comes with two themes by default.

More themes can be easily added by creating a zip-file containing the images (in png format) and a
"Theme.prefs” file to describe the theme. The zip-file has to be copied to the "Themes” folder in the
SpiderBasic installation directory to be recognized by the IDE. The ”SilkTheme.zip” file can be used as
an example to create a new theme.

Display Icons in the Menu

Allows to hide/show the images in the IDE menus.

Show main Toolbar

Allows to hide/show the main toolbar in order to gain space for the editing area.

General - Toolbar

Toolbar Layout
lcon Action 0
Theme lcon: New Menu kem: New
Theme lcon: Open Menu tem: Open.. =
Theme lcon: Save Menu tem: Save
Separator
Theme lcon: Close Menu tem: Close
Separatar
Theme lcon: Cut Menu tem: Cut
Theme lcon: Copy Menu tem: Copy
Theme lcon: Paste Menu ltem: Paste
Separator
Theme Iean- Lndn Merus bam - Lindn =

ltem Settings Pasition

[Theme Jean v] = [Clese -] [ w |

T g

[ ] [ sa | [ Remove |

Default Sets

[ Default Toolbar ] [ Classic Toolbar ]

This allows to fully customize the main Toolbar. By selecting an entry and using the Buttons in the
"Position” section, you can change the order. The "Item Settings” section can be used to modify the
entry or add a new one. New ones are always added at the end of the list.

Types of items:

Separator : a vertical separator line.

Space : an empty space, the size of one toolbar icon.

Standard Icon : allows you to select a OS standard icon from the combo box on the right.

IDE Icon : allows you to select one of the IDE’s own icons in the combo box on the right.

Icon File : allows you to specify your own icon file to use in the edit box on the right (PNG files are
supported on all platforms, Windows additionally supports icon files).
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If you do not select a separator or space, you can specify an action to carry out when the button is
pressed:

Menu Item : carries out the menu command specified in the combo box on the right.

Run tool : executes the external tool specified in the combo box on the right.

The "Default Sets” section contains two standard toolbar sets which you can select, and later modify.

Editor
File: selection
[ Display muttiple rows
Display close buttons in each tab
[7] Add a tab to create a new source
Editor
Monitor open files for changes on disk
Auto-save before compiling
Save all sources with Auto-save
Memarize Cursor position
Memorize Marker positions

|| Always hide the emor log {ignore the per-<ource setting)

Save Settings to: A common file project .cfg for every directory - ]
Tab Length: 2 [7] Use real Tab (ASCH 9)
Source Directory: C\PureBasichLibraries cument Json®, :]

Code file extensions:

Settings that affect the management of the source codes.

Monitor open files for changes on disk

Monitors all open files for changes that are made to the files on disk while they are edited in the IDE. If
modifications are made by other programs, a warning is displayed with the choice to reload the file from
disk.

Auto-save before compiling

Saves the current source code before each compile/run or executable creation. Note that any open
include files are not automatically saved.

Save all sources with Auto-save

Saves all sources instead of just the current one with one of the Auto-save options.

Memorize cursor position

Saves the current cursor position, as well as the state of all folding marks with the compiler options for
the source file.

Memorize Marker positions

Saves all the Markers with the options for the source file.

Always hide the error log

The error log can be shown/hidden on a per-source basis. This option provides a global setting to ignore
the per-source setting and never display the error log. It also removes the corresponding menu entries
from the IDE menu.

Save settings to

This option allows to specify where the compiler options of a source file are saved:

The end of the Source file

Saves the settings as a special comment block at the end of each source file.

The file <filename>>.sb.cfg

Creates a .sb.cfg file for each saved source code that contains this information.

A common file project.cfg for every directory

Creates a file called project.cfg in each directory where PB files are saved. This one file will
contain the options for all files in that directory.

Don’t save anything
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No options are saved. When reopening a source file, the defaults will always be used.

Tab Length

Allows to specify how many spaces are inserted each time you press the Tab key.

Use real Tab (Ascii 9)

If set, the tab key inserts a real tab character instead of spaces. If not set, there are spaces inserted
when Tab is pressed.

Note that if real tab is used, the "Tab Length” option specifies the size of one displayed tab character.
Source Directory

Specifies the default directory used in the Open and Save dialogs if no other files are currently open (if
another file is open, its path will be used as default).

Set this to the path were you usually save the source codes.

Code file extensions

The IDE detects code files by their extension (sb, sbi or sbf by default). Non-code files are edited in a
"plain text” mode in which code-related features are disabled. This setting causes the IDE to recognize
further file extensions as code files. The field can contain a comma-separated list (i.e. "sbx, xyz”) of
extensions to recognize.

Editor - Editing

Editing
Select Fort | AaBbCc 01234 +-*/()

Enable bolding of Keywords

Enable Case comection

Enable marking of matching Braces
Enable marking of matching Keywords
Display Line numbers

Use "Select Font” to change the font used to display the source code. To ensure a good view of the
source code, it should be a fixed-size font, and possibly even one where bold characters have the same
size as non-bold ones.

Enable bolding of keywords

If your font does not display bold characters in the same size as non-bold ones, you should disable this
option. If disabled, the keywords will not be shown as bold.

Enable case correction

If enabled, the case of SpiderBasic keywords, SpiderBasic Functions as well as predefined constants will
automatically be corrected while you type.

Enable marking of matching Braces

If enabled, the brace matching the one under the cursor will be highlighted.

Enable marking of matching Keywords

If enabled, the keyword(s) matching the one under the cursor will be underlined.

Display line numbers

Shows or hides the line number column on the left.
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Editor - Coloring

Coloring
Nomal Ted:

Background:

Background for plain text files
Cursor.

Selection Text

Selection Background

Repeated Selections Background.

=

Currentline Background

=l

LineHumbers:

=

Line Markers:

=l

LineMumbers Background:

=

1LERUOROR0CN
aalafafalafaiafalainy

Basic Keywords:

g

Default Color Schemes: [

1
tn
&

Here you can change the color settings for the syntax coloring, as well as the debugger marks. Default

color schemes can be selected from the box on the bottom, and also modified after they have been set.

Individual color settings can be disabled by use of the checkboxes.

Note: The ’Accessibility’ color scheme has (apart from high-contrast colors) a special setting to always

use the system color for the selection in the code editor. This helps screen-reader applications to better
detect the selected text.

Editor - Coloring - Custom Keywords

Custom keywords:

=

Load keywords from file:

In this section, a list of custom keywords can be defined. These keywords can have a special color
assigned to them in the coloring options and the IDE will apply case-correction to them if this feature is
enabled. This allows for applying a special color to special keywords by preprocessor tools or macro sets,
or to simply have some PB keywords colored differently.

Note that these keywords take precedence above all other coloring in the IDE, so this allows to change
the color or case correction even for SpiderBasic keywords.

The keywords can be either entered directly in the preferences or specified in a text file with one
keyword per line (or both).
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Editor - Folding

Folding
Enable Source Line folding

Folding start Keywords

T

il
Compilertf
DeclareModule
Macro

Module
Procedurs
ProcedureC
ProcedursCDLL -

m

Folding end Keywords
b

CompilerEndif
EndDeclareModule
EndMacro
EndModule
EndProcedure

Here you can set the keywords in the source code that start/end a foldable section of code. You can add
any number of words that will mark such a sections. You can also choose to completely disable the
folding feature.

Words that are found inside comments are ignored, unless the defined keyword includes the comment
symbol at the start (like the default ”;{” keyword).

A keyword may not include spaces.

Editor - Indentation

Code Indentation

(7 No indentation [T Show indentation quides

(7 Block mode [ Show whitespace characters

(@) Keyword sensitive

Keyword Before After e
Case L
CompilerCase 1
CompilerDefautt

CompilerElse

CompilerBlself

CompilerEndif

CompilerEndSelect
Compilerlf
CompilerSelect
DataSection
DeclareModule
Default

LEeeE gy L L L L L
R = T A

Keyword: Before After:

CompilerBseff -1 1

Here you can specify how the editor handles code indentation when the return key is pressed.

No indentation

Pressing return always places the cursor at the beginning of the next line.

Block mode

The newly created line gets the same indentation as the one before it.

Keyword sensitive

Pressing the return key corrects the indentation of both the old line and the new line depending on the
keywords on these lines. The rules for this are specified in the keyword list below. These rules also apply
when the "Reformat indentation” item in the edit menu is used.

Show indentation guides

Causes vertical lines to be shown to visualize the indentation on each line. This makes it easier to see
which source lines are on the same level of indentation.

Show whitespace characters

Causes whitespace characters to be visible as little dots (spaces) or arrows (tab characters).

The keyword list contains the keywords that have an effect on the indentation. The "Before” setting
specifies the change in indentation on the line that contains the keyword itself while the "After” setting
specifies the change that applies to the line after it.
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Editor - Auto complete

AutoComplete
_ Display the full AutoComplete list
_ Display all words that match the first character
@) Display only words that begin with the typed word

Booe width: 230
Box height: 300

|| Add opening Brackets to Functions/Amays/Lists
[ 7] Add a Space after PB Keywords followed by an expression
[7] Add matching 'End’ keyword ff insert is pressed twice

Automatically popup AutoComplete for Structure tems
Automatically popup AutoComplete after a Module prefic
Automatically popup AutoComplete otherwise

3 Characters needed before opening the list

Display the full Auto complete list

Always displays all keywords in the list, but selects the closest match.

Display all words that start with the first character

Displays only those words that start with the same character as you typed. The closest mach is selected.
Display only words that start with the typed word

Does not display any words that do not start with what you typed. If no words match, the list is not
displayed at all.

Box width / Box height

Here you can define the size of the auto complete list (in pixel). Note that these are maximum values.
The displayed box may become smaller if there are only a few items to display.

Add opening Brackets to Functions/Arrays/Lists

Will automatically add a ”(” after any function/Array/List inserted by auto complete. Functions with no
parameters or lists get a ”()” added.

Add a Space after PB Keywords followed by an expression

When inserting PB keywords that cannot appear alone, a space is automatically added after them.

Add matching End’ keyword if Tab/Enter is pressed twice

If you press Tab or Enter twice, it will insert the corresponding end keyword (for example "EndSelect” to
"Select” or "EndIf ” to "If”) to the keyword you have just inserted. The end keyword will be inserted
after the cursor, so you can continue typing after the first keyword that was inserted.

Automatically popup AutoComplete for Structure items

Displays the list automatically whenever a structured variable or interface is entered and the ”\”
character is typed after it to show the list of possible structure fields. If disabled, the list can still be
displayed by pressing the keyboard shortcut to open the AutoComplete window (usually Ctrl+Space,
this can be modified in the Shortcuts section of the Preferences).

Automatically popup AutoComplete outside of Structures

Displays the list automatically when the current word is not a structure after a certain amount of
characters has been typed, and a possible match in the list is found. If disabled, the list can still be
displayed by pressing the assigned keyboard shortcut.

Characters needed before opening the list

Here you can specify how many characters the word must have minimum before the list is automatically
displayed.
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Editor - Auto complete - Displayed items

ltems to display in the AutoComplete List

Sourcecode ftems Predsfined ttems
Varizbles Keywords
Amays [C] ASM Keywords
LinkedLists Library Functions
Maps [T] API Functions
Procedures Constants
Macros [ Structures
Imported Functions [C] Interfaces
Constants

Modules

[] Prototypes

[ Structures

[ Interfaces

[] Labels

Add kems from:

() the cument source onhy

@) the cumert project (f any)

() the curmert project or all files f none)

) all open files

This shows a list of possible items that can be included with the possible matches in the AutoComplete
list.

Source code Items

Items defined in the active source code, or other open sources (see below).

Predefined Items

Items that are predefined by SpiderBasic, such as the SpiderBasic keywords, functions or predefined
constants.

Add Items from: the current source only

Source code items are only added from the active source code.

Add Items from: the current project (if any)

Source code items are added from the current project if there is one. The other source codes in the
project do not have to be currently open in the IDE for this.

Add Items from: the current project or all files (if none)

Source code items are added from the current project. If the current source code does not belong to the
open project then the items from all open source codes will be added.

Add Items from: all open files

Source code items are added from all currently open source codes.

Editor - Issues

lssues

Name Expression Priority

@3 Todo \BTODO' Info

EJ Foame: \bFIXME'D. High

lssue name: Fime
Regular exression: “bFIXME'b *
Priory: [Ej[ High -
co I .|

(Z) No code color Show in issue tool

(@) Change issue background [] Show in procedure browser

() Change line backaground

Allows to configure the collection of ’issue’ markers from comments in the source code. Issue markers
can be displayed in the Issues or ProcedureBrowser tool, and they can be marked within the source code
with a separate background color.

A definition for an issue consists of the following:

Issue name
A name for the type of issue.
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Regular expression

A regular expression defining the pattern for the issue. This regular expression is applied to
all comments in the source code. Each match of the expression is considered to match the
issue type.

Priority

Each issue type is assigned a priority. The priority can be used to order and filter the
displayed issues in the issue tool.

Color

The color used to mark the issue in the source code (if enabled). The color will be used to
mark the background of either only the issue text itself, or the entire code line depending on
the coloring option.

Show in issue tool

If enabled, any found issues of this type are listed in the issues tool. This option can be
disabled to cause an issue to only be marked in the source code with a special background
color if desired.

Show in procedure browser

If enabled, any found issues are shown as an entry in the procedure browser tool.

Editor - Session history

Session History
Enable recarding of history (change requires a restart)

Record unsaved changes every 5 minutes

Record anly changes to files smallerthan 2048 kilobytes

Purge old sessions from history

_ Keep all history
) Keep madmum 20 sessions
@ Keep sessionsfor 30 days

Database location: C:\PureBasicPackage cument\History db
Database size: 84.00 Kb

Allows to configure how the session history is recording changes.

Enable recording of history

Enable or disable the history session recording. When enabled, all the changes made to a file will be
recorded in the background in a database. A session is created when the IDE launch, and is closed when
the IDE quits. This is useful to rollback to a previous version of a file, or to find back a deleted or
corrupted file. It’s like a very powerful source backup tool, limited in time (by default one month of
recording). It’s not aimed to replace a real source versioning system like SVN or GIT. It’s
complementary to have finer change trace. The source code will be stored without encryption, so if you
are working on sensitive source code, be sure to have this database file in a secure location, or disable this
feature. It’s possible to define the session history database location using an IDE command-line switch.
Record change every X minutes

Change the interval between each silent recording (when editing). A file will be automatically recorded
when saving or closing it.

Record only changes to files smaller than X kilobytes

Change the maximum size (in kilobytes) of the files being recorded. This allow to exclude very big files
which could make the database grow a lot.

Keep all history

Keep all the history, the database is never purged. It will always grows, so it should be watched.

Keep maximum X sessions

After reaching the maximum number of sessions, the oldest session will be removed from the database.
Keep sessions for X days

After reaching the maximum number of days, the session will be removed from the database.
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Compiler

Default web server port | 5083
Default Compiler
SpiderBasic 1.00 (Windows - x86)
C:A\PureBasich\Svn'w5.40"Build"\SpiderBasic_x86"Compilers‘\sbcompiler.exe

Additional Compilers

Version Path

Add Remove Clear

This page allows to select additional compilers which should be available for compilation in the Compiler
Options . This allows switching between different compilers of the same version (like the x86 and x64
compilers) or even switching between different versions easily.

Any SpiderBasic compiler can be added here. The target processor of the selected compilers does not
have to match that of the default compiler, as long as the target operating system is the same. The list
displays the compiler version and path of the selected compilers.

The information used by the IDE (for code highlighting, auto complete, structure viewer) always comes
from the default compiler. The additional compilers are only used for compilation.

Compiler - Defaults

Default Settings for new Files

Show Emor Log [ #PB_Editor_CompileCount
Enable Debugger [ #PB_Editor_BuildCourt
[] Enable Purifier [ #PB_Editor_CreateExecutable

[] Enable inline ASM syntax coloring [] Enable OnEmor lines support
Create unicode executable [ Create threadsafe executable
Enable modem theme support for Windows XP and above)

[ Request Administrator mode for Windows Vista and above

[ Request User mode for Windows Vista and above {no vitualisation)

[] Create temporary executable in the source directory

Current directory: z]
Library Subsystem

Executable format: [Winduws e ]
CPU Optimisation: [N\ CPU v ]
Sourcelile Text encoding:  [UTF8 -
Sourcefile Newline format [Windnws (CRLF) ']

This page allows setting the default compiler options that will be used when you create a new source
code with the IDE.
For an explanation of the meaning of each field, see the Compiler Options .
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Debugger

Debugger-Typ auzwahlen wiarnhimweiz-Stufe auswahlen

Integrieter Debugger v W arnungen anzeigen v
Allgemeine O ptionen
Fensterpositionen des Debuggers merken
Alle Debugger-Fenster im Yardergrund halten

[] &lle Debugger-Fanster in den Yordergrund, wenn sines den Fokus ethalt

Zeitangabe im Fehlerprotokoll anzeigen
[ swsfiibrung am Programmetart stoppen

[ swsfishrung vor dem Programmende stoppen

[ Proaramm nach einem Fehler beenden
Fehler-Markieungen nach Programmende beibehalten

[] Fehlerpratokal bei jedem Stat [dschen

Zeitlimit fuir den Start des Debuggers [Millizekunden]: (10000

Settings for the internal Debugger, or the Standalone Debugger. The command-line debugger is
configured from the command-line only.

Debugger Type

Select the type of debugger you want to use when compiling from the IDE here.

Choose Warning level

Select the action that should be taken if the debugger issues a warning. The available options are:
Ignore Warnings: Warnings will be ignored without displaying anything.

Display Warnings: Warnings will be displayed in the error log and the source code line will be marked,
but the program continues to run.

Treat Warnings as Errors: A warning will be treated like an error.

Memorize debugger window positions

The same as the "Memorize Window positions” for in the General section, but for all Debugger windows.
Keep all debugger windows on top

All debugger windows will be kept on top of all other windows, even from other applications.

Bring Debugger windows to front when one is focused

With this option set, focusing one window that belongs to the debugger of a file, all windows that belong
to the same debugging session will be brought to the top.

Display Timestamp in error log

Includes the time of the event in the error log.

Stop execution at program start

Each program will be started in an already halted mode, giving you the opportunity to start moving
step-by-step, right from the start of the program.

Stop execution before program end

Stops the program execution right before the executable would unload. This gives you a last chance to
use the debugging tools to examine Variables or Memory before the program ends.

Kill Program after an Error

If a program encounters an error, it will be directly ended and all debugger windows closed. This gives
the opportunity to directly modify the code again without an explicit "Kill Program”, but there is no
chance to examine the program after an error.

Keep Error marks after program end

Does not remove the lines marked with errors when the program ends. This gives the opportunity to still
see where an error occurred while editing the code again.

The marks can be manually removed with the "Clear error marks” command in the "Error log” submenu
of the debugger menu.

Clear error log on each run

Clears the log window when you execute a program. This ensures that the log does not grow too big
(this option is also available with the command-line debugger selected).

Timeout for Debugger startup

Specifies the time in milliseconds how long the debugger will wait for a program to start up before giving
up. This timeout prevents the debugger from locking up indefinitely if the executable cannot start for
some reason.
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Debugger - Individual Settings

This allows setting options for the individual debugger tools. The "Display Hex values” options switch
between displaying Byte, Long and Word as decimal or hexadecimal values.

Debug-Ausgabe

[ Hex*Werte anzeigen

[[]Zeitangahe hinzufiigen

[] Debugdusgabe im Fehlemprotakall ausgeben

[T] Eigenen Zeichensatz verwenden:

Frogrammanalyze

Programmanalyse bei Programmstart aktivieren

Asm-Debugger

[] Reaister al: Hex anzeigen

[[] Stapel ale Hex anzeigen

Stapelverfolgung automatizch aktualisieren

Speicheranzeiger “ariablenliste

[ Hex*werte anzeigen [ Hex*werte anzeigen

[ ssmray-dnsicht nur in einer Spalte

Debug Output Add Timestamp

Adds a timestamp to the output displayed from the Debug command.

Debug Output - Display debug output in the error log

With this option enabled, a Debug command in the code will not open the Debug Output window, but
instead show the output in the error log .

Debug Output Use custom font

A custom font can be selected here for the debug output window. This allows to specify a smaller font
for much output or a proportional one if this is desired.

Profiler - Start Profiler on program startup

Determines whether the profiler tool should start recording data when the program starts.

ASM Debugger Update Stack trace automatically

Updates the stack trace automatically on each step/stop you do. If disabled, a manual update button
will be displayed in the ASM window.

Memory Viewer Array view in one column only

If the memory area is displayed in array view, this option selects whether it should be multi-column
(with 16 bytes displayed in each column) or with only one column.

Debugger - Default Windows

{ffne Fenster zum Debugger-Start
[ bebugduzgabe

[ &sm-Debugger

[ Speicheranzeiger

[ ariablenliste

[] Programmanalyse

[ Prozeduren-sufufverfolgung
[ Libray énzeiger

[[] Beobachtungsliste

The debugger tools you select on this page will automatically be opened each time you run a program
with enabled debugger.
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Tools Panel

Tools in the ToolsPanel

Available Tools: Displayed Tools:
Form Panel Add Procedurs Browser
Asci Table Explorer

Explorer E— Form Panel

Project Panel E — Project Panel
Color Picker
Procedure Browser
Vaniable Viewsr
Help Toal

Configuration - Procedure Browser

[] Sort Procedures by name
[7] Group Markers
["] Display Procedure Argumerts

This allows configuring the internal tools that can be displayed in the side panel. Each tool that is in the
"Displayed Tools” list is displayed in the Panel on the side of the edit area. Each tool that is not listed
there is accessible from the Tools menu as a separate window.

Put only those tools in the side panel that you use very frequently, and put the most frequently used
first, as it will be the active one once you open the IDE.

By selecting a tool in either of the lists, you get more configuration options for that tool (if there are
any) in the "Configuration” section below.

Here is an explanation of those tools that have special options:

Explorer

You can select between a Tree or List display of the file-system. You can also set whether the last
displayed directory should be remembered, or if the Source Path should be the default directory when
the IDE is started.

Procedure Browser

"Sort Procedures by Name” : sorts the list alphabetically (by default they are listed as they appear in
the code).

”Group Markers” : groups the ”;-” markers together.

"Display Procedure Arguments” : Displays the full declaration of each procedure in the list.

Variable Viewer

The "Display Elements from all open sources” option determines whether the list should only include
items from this code, or from all open codes.

Furthermore you can select the type of items displayed in the Variable viewer.

Help Tool

”Open sidebar help on F17: specifies whether to open the help tool instead of the separate help viewer
when F1 is pressed.

Tools panel - Options

ToolsPanel Options
[Panel on the right side - ]

[] Use a custom font: Select Fi

Use custom colors Front Color - :]
Background Color: l:l E]

Do not use colors/fonts fortools in extemal windows
[] Automaticalty hide the Panel

2500

Here you can customize the appearance of the Tools Panel a bit more. You can select the side on which
it will be displayed, a Font for its text, as well as a foreground and background color for the displayed
tools. The font and color options can be disabled to use the OS defaults instead.

Do not use colors/fonts for tools in external windows

If set, the color/font options only apply to the Tools displayed in the Panel, those that you open from
the Tools menu will have the default colors.
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Automatically hide the Panel

To save space, the Panel will be hidden if the mouse is not over it. Moving the mouse to the side of the
IDE will show it again.

Milliseconds delay before hiding the Panel

Sets a timeout in ms, after which the Panel is hidden if you leave it with the mouse.

Import /Export
Export Settings
Include Shortcut settings Include Color settings
Include Toolbar layout Include Folding keywords
Save to: :]
Save ]
Import Settings
Load from: :]
Cpen
Include Shortcut settings Include Color settings
Include Toolbar layout Include Folding keywards
mport Settings

This section allows you to export the layout settings of the IDE in a platform independent format, which
allows you to import them again into the SpiderBasic IDE on another Operating System, or to share
your options with other PB users.

To export your settings, select what types of settings you want to include, select a filename and press the
”Save” button.

To import settings, select the filename and press "Open”. You will then see the options that are included
in this file as enabled checkboxes. After selecting what you want to import, click the "Import Settings”
button.

For the new settings to take effect, you have to first click the apply button.

Note: You can import the style files from the jaPBe Editor, but only the color settings will be imported.
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Chapter 17

Command-line options for the IDE

The SpiderBasic IDE allows you to modify the paths and files being used from the command-line. This
allows you to create several shortcuts that start the IDE with different configurations for different users,
or for different projects.

There are also options for compiling SpiderBasic projects directly from the command-line. Building a
project from the command-line involves the same actions like at choosing the 'Build Target’ or 'Build all
Targets’ from the compiler menu .

General options:

/VERSION displays the IDE version and exits
/HELP or /7 displays a description of the command-line
arguments

Options for launching the IDE:

/P <Preferences file> loads/saves all the configuration to/from
the given file

/T <Templates file> loads/saves the code templates from/to the
given file

/A <tools file> loads/saves the configuration of the
external tool from/to this file

/S <Source path> overwrites the "Source path" setting from
the preferences

/E <Explorer path> starts the Explorer tool with the given path

/L <Line number > moves the cursor to the given line number in
the last opened file

/H <HistoryDatabase> specify the file to use for the session
history database

/NOEXT disables the registering of the .sb
extension in the registry

/LOCAL puts all preferences in the SpiderBasic
directory instead of the user profile location

/PORTABLE the same as /LOCAL and /NOEXT combined

Options for building projects:

/BUILD <file> specifies the project file to build

/TARGET <target> specifies the target to build (the default
is to build all targets)

/QUIET hides all build messages except errors

/READONLY does not update the project file after

compiling (with new access time and build counters)

The default files for /P /T and /A are saved in the %APPDATA%\SpiderBasic\ directory on the system.
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The /NOEXT command is useful when you have several different SpiderBasic versions at once (for
testing of beta versions for example), but want the .sb extension to be associated with